SON OF STUPID MAC TRICKS

14 new insanely great tricks for your Macintosh®
Son of Stupid Mac Tricks
Son of Stupid Mac Tricks

Bob LeVitus

Addison-Wesley Publishing Company, Inc.
Reading, Massachusetts ◊ Menlo Park, California ◊
New York ◊ Don Mills, Ontario ◊ Wokingham, England ◊
Amsterdam ◊ Bonn ◊ Sydney ◊ Singapore ◊ Tokyo ◊ Madrid ◊
San Juan ◊ Paris ◊ Seoul ◊ Milan ◊ Mexico City ◊ Taipei
Many of the designations used by manufacturers and sellers to distinguish their products are claimed as trademarks. Where those designations appear in this book and Addison-Wesley was aware of a trademark claim, the designations have been printed in initial capital letters (i.e., Macintosh).

Copyright ©1991 by Bob LeVitus

All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted, in any form or by any means, electronic, mechanical, photocopying, recording, or otherwise, without the prior written consent of the publisher. Printed in the United States of America. Published simultaneously in Canada.

Sponsoring Editor: Rachel Guichard
Technical Reviewer: Raines Cohen
Cover design by Ronn Campisi
Text design by Joyce Weston
Set in 11-point Bitstream Latin 725 by Bob LeVitus
123456789—MW—9594939291
First printing, July 1991
ISBN 0-201-56787-3
Addison-Wesley warrants the enclosed diskette to be free of defects in materials and faulty workmanship under normal use for a period of 90 days after purchase. If a defect is discovered in the diskette during this warranty period, a replacement diskette can be obtained at no charge by sending the defective diskette, postage prepaid, with proof of purchase, to:

Addison-Wesley Publishing Company, Inc.
Trade Computer Books Division
Route 128
Reading, Massachusetts 01867

After the 90-day period, a replacement will be sent upon receipt of the defective diskette and a check or money order for $10, payable to Addison-Wesley Publishing Company.

Addison-Wesley makes no warranty or representation, either express or implied, with respect to this software, its quality, performance, merchantability, or fitness for a particular purpose. In no event will Addison-Wesley, its distributors, or dealers be liable for direct, indirect, special, incidental, or consequential damages arising out of the use or inability to use the software.

The exclusion of implied warranties is not permitted in some states. Therefore, the above exclusion may not apply to you. This warranty provides you with specific legal rights. There may be other rights that you may have that vary from state to state.
For the programmers who dared to dream them up—you are the true heroes of *Son of Stupid Mac Tricks*. 
# Table of Contents

*Preface* ............................................................................. 11  
*Acknowledgments* ............................................................ 15  
*Introduction* ................................................................. 17

**The Tricks**

Reagan's Watching .......................................................... 23  
Subliminal ................................................................ 31  
Critters—Eyeballs and BigFoot ..................................... 39  
CursorAnimator ............................................................... 43  
Finder Sounds .............................................................. 51  
Fruits of Passion ........................................................... 57  
Shutdown Slide .............................................................. 61  
Mouse Odometer .......................................................... 65  
NavCom ...................................................................... 69  
ARRGH!!! .................................................................. 75  
BigBen ........................................................................ 79  
Key Lights ................................................................. 83  
Shakespeare .............................................................. 87  
Sexplosion II ............................................................. 91

*Glossary* ........................................................................... 95
Before I try to explain why I'm at it again, I'd like to thank you for buying this book. (If you are standing in the store reading this, go directly to the counter and buy it right now. You won't be sorry.)

The Stupid series of books/disks was born at the Moscone Center in San Francisco, in the spring of 1990. I was having lunch with one of my Addison-Wesley editors, Carole McClendon. We were munching horrible hamburgers at a concession stand at Macworld Expo, trying to come up with a follow-up to my first “serious” book, *Dr. Macintosh*. It wasn't going well. I kept pitching ideas; she kept shooting them down.

"How 'bout a book on desktop video," I said between mouthfuls of mystery meat, "It's going to be the next big thing."
Carole hesitated only briefly before telling me the potential market wasn’t big enough yet. “Maybe in a year or two.”


“It’s been done already.”

“Word processing secrets?”

“That’s been done, too.”

“Macromind Director?”

“The market’s too small.”

“Power user techniques?”

“Too much like Dr. Macintosh.”

Finally, I threw my hands up in frustration and said, “Well then, how ‘bout something really important. Let’s do a book about really relevant software like the Talking Moose and MacBarf.”

To understand just how silly that statement was, you need to know a little about my publisher, Addison-Wesley. They’re a huge mega-conglomerate, among the biggest in educational, technical, engineering, scientific, and computer books—a generally conservative organization that is the home of the official Apple and Adobe technical libraries. I never in a million years would have expected them to buy a book about something called MacBarf.

But they did. And the rest, as they say, is history.

Ultimately, 14 tricks were included in Stupid Mac Tricks. I had plenty more that were great and appropriately stupid, but I couldn’t fit them on the disk. I stashed them away in a folder on my hard disk and waited for the day that Addison-Wesley would ask me to do a sequel to Stupid Mac Tricks.
That day arrived early in 1991, and the book/disk you’re holding in your hand is the result.

I hope you’ll have as good a time using these tricks to delight, amuse, and entertain yourself, your friends, and your co-workers as I had collecting them. And that’s a real good time!

Bob LeVitus
Summer, 1991
Acknowledgments

I'd like to take a moment to thank everyone who helped make this project possible—I couldn't have done it without you.

First and foremost, thanks to all the programmers who gave me permission to include their tricks in this collection. Thanks to everyone who bought a copy of the original Stupid Mac Tricks: Without your support this sequel would never have been possible.

Special thanks to my editors: Rachel Guichard, who never underestimated the appeal of the stupid books; Joanne Clapp Fullagar, who made sure the tricks were consistently stupid; and Carole McClendon, who first took the chance on stupid publishing. Many thanks also to Steve Stansel, Abby Cooper, Kathy Traynor, and everyone else at Addison-Wesley; Tema Goodwin; and Raines Cohen. Finally, thanks to Bill "Swifty" Gladstone and Matt Wagner of Waterside productions; everyone on CompuServe, GEnie, and America Online, especially Marty Silbernik, who made suggestions about stupid stuff to include; and M & L Typesetting.

In another vein completely, I want to thank Cozolli's Pizzaria, Iron Works Barbecue, Shiner Bock and Sierra Nevada beers, Bookstop, B. Dalton and WaldenBooks bookstores, Federal Express, UPS, and Rene of the United States Postal Service—all made some valuable contribution to this extravaganza.

Extra special thanks to my wife Lisa and daughter Allison, for putting up with me, the Macs, and the funny noises.

And finally: Thanks, Mom.
Introduction

System Requirements

First, here's what you'll need to use Son of Stupid Mac Tricks: a Macintosh Plus, SE, Portable, LC, or II series computer; a hard disk drive; a floppy disk drive; and Macintosh System Software version 6.0.2 or later. When this book was written, System 7 had not yet been released, but I tested each trick with a prerelease (beta) version, and all except Finder Sounds and Fruits of Passion worked. Note that all System 7 testing was done with 32-bit addressing turned off. If you use 32-bit addressing and have a problem with one of the tricks, try it again with 32-bit addressing turned off. (System 7 users only: To turn off 32-bit addressing, choose Control Panels from the Apple menu, then double-click the Memory control panel's icon. If your Mac supports 32-bit addressing—only the IIci, IIfx, Ilsi, and LC do on the day I wrote this—you'll see on and off buttons for 32-bit addressing. Turn it off, then restart your Mac. If your Mac doesn't support 32-bit addressing, ignore this entire parenthetical comment.)
Before You Install the Tricks

Some tricks may conflict with other programs you use. In particular, many of the tricks are INITs (Initial or Startup documents) and cdevs (Control Panel Devices) and may conflict with other INITs and cdevs you already have running on your Macintosh. To be safe, first remove any INITs or cdevs from your System Folder that might conflict with the tricks.

_UNDER SYSTEM 6:_ You can identify INITs and cdevs by first opening the System Folder and then choosing "by Kind" from the View menu.

Look under the Kind column for Control Panel documents and Startup documents. There are several that are standard to the Macintosh and that you need to keep, such as "Mouse" and "Keyboard." Only remove anything that looks unusual—probably the ones you added yourself. **DO NOT** throw these unusual items in the Trash; just drag them out of the System Folder and put them somewhere else on your hard disk.

_UNDER SYSTEM 7:_ INITs will be found in the Extensions folder and cdevs in the Control Panels folder, both of which can be found in your System Folder.

There are several that are standard to the Macintosh and that you need to keep, such as "Mouse," "General Controls," "File Sharing Extension," "Keyboard," and several others. Only remove anything that looks unusual—probably the ones you added yourself. **DO NOT** throw these unusual items in the Trash; just drag them out of the System Folder and put them somewhere else on your hard disk.
Now you’re ready to install the tricks! By the way, under any version of the System, you can later return the INITs and cdevs you removed to your System Folder. Just drag one INIT or cdev into the System Folder and then choose Restart from the Special menu. If you reboot successfully, repeat the process for each INIT or cdev you removed.

**How To Install the Tricks**

The Son of Stupid Mac Tricks disk contains more than 1000K of fun. We’ve used special compression technology to fit it all on a single 800K floppy disk. So, before you can use the tricks, you’ll have to decompress them. It’s easy. Here’s how:

Put the Son of Stupid Mac Tricks disk in any floppy disk drive. Double-click the Son of Stupid Installer icon. Now, using the standard file dialog box, locate the hard disk where you want the tricks installed and then click the Extract button. (See Figure 1, *Installing Son of Stupid Mac Tricks.*)

![Select Destination Folder: Cruella](image)

Figure 1. Installing Son of Stupid Mac Tricks:
Use the standard file dialog box to select a hard disk to install the tricks on, in this case, Cruella.
A screen with a gauge showing the progress of the installer will appear. When it gets to 100%, there will be a folder entitled "Son of Stupid Mac Tricks Folder" on the hard disk you selected. The process will take about ten minutes or less, depending on the kind of Mac you have.

All of the tricks are now in the Son of Stupid Mac Tricks folder. Each is described in its own chapter. Follow the specific directions for each trick, and don't forget that if a folder contains a file called Read Me or one with "Doc" (for documentation) in its name, you should probably read it before using that particular trick.

And now a word about our special compression technology: This program is being distributed in a Compact Pro (formerly called "Compactor") archive. Compact Pro is a file compression utility by Bill Goodman. If you're interested in obtaining a copy, it's available on most online services or BBSs, and from most Macintosh user groups. Or you can order a copy directly from the author for $35. (Write to: Bill Goodman, 109 Davis Avenue, Brookline, MA 02146. Massachusetts residents add 5% sales tax. VISA, MasterCard, check, or money order is acceptable. Checks and money orders must be drawn on a U.S. bank in U.S. dollars.)

Using the Tricks

One more note about using the tricks. Despite your careful preparation of removing all unusual INITs and cdevs from your System Folder, you may experience a crash with a particular trick. If you attempt to use a trick and you do experience a crash, restart. If you immediately crash again while attempting to restart, follow these steps:
• Turn off your Mac at the back switch.
• Insert any floppy startup disk.
• Turn on your Mac.
• Open the System Folder of the Mac you installed the tricks on (most probably your hard disk).
• Move the trick that initiated the crash out of the System Folder.
• Restart your Mac from the original hard disk rather than the floppy.

If a particular trick continually crashes your system, I encourage you to contact the author of the trick directly. Most of the tricks come with documentation or help files that tell you how to get in touch with the author.

Disclaimer

I make no claims about the performance of the tricks on the Son of Stupid Mac Tricks disk. I have tested each one on a variety of Macs, using several versions of the System software, and they seem to work as advertised in my (albeit) limited testing. I feel relatively certain that they are not going to do any damage to your Mac (like trash your hard disk or burn up your motherboard). However, I make no guarantees—use them at your own risk.

I'm a firm believer in backing up your hard disk. I strongly recommend that there be a backup available before you try these tricks on yourself or others. If you don't have one, I suggest you create one now, just in case.

Some tricks may conflict with other programs you use. There was no way I could test every possible combination of hardware and software. I apologize if something doesn't work on your particular setup, but I cannot be held responsible.
Reagan’s Watching

What Reagan’s Watching Does

Reagan’s Watching is one of the stupidest Mac tricks I’ve ever seen. What could be dumber than Ronald Reagan watching everything you do. His beady eyes follow the cursor as you move it around the screen. (See Figure 2, Reagan’s Watching.) If it weren’t so ludicrous you might find his eyes spooky, but this thing is so darn silly...

To add to the absurdity, he speaks only when his eyes are crossed. “I cannot remember any meetings,” “I don’t recall,” and even an occasional “Oh, dear!” We’re talking extremely stupid here, folks.

Oh, and if you don’t move the cursor for a while, Reagan falls asleep. No snores, but check out his expression—it’s classic.
How to Use Reagan's Watching

Reagan's Watching is an application—a program. Just double-click it. He works best under MultiFinder. He will work under the regular Finder, but he won't talk. He's the most fun under MultiFinder, so try him that way if you possibly can.

System 6.0.x users: If you don't normally use MultiFinder, you should turn it on now. Go ahead, I'll wait. (Pssst. If you're not sure how, take a look at the helpful sidebar.)

System 7 users: System 7 no longer has Finder and MultiFinder—it always runs in the MultiFinder mode. So if you're using System 7, you can ignore the helpful sidebar. I tested Reagan's Watching with a beta version of System 7 and it worked. I can't promise that it will work with the release version of System 7, but it should.
To turn MultiFinder on:

1. Select the icon of your startup disk.
2. Choose Set Startup from the Finder’s Special menu.
3. Select MultiFinder and MultiFinder Only, as shown in Figure 3, *MultiFinder Startup*.

![MultiFinder Startup](image)

Figure 3. MultiFinder Startup:
Click the MultiFinder and MultiFinder Only buttons, then restart your Mac.

4. Restart your Mac.
5. To go back to using the Finder, repeat the process, choosing Finder and Finder Only in the dialog box. Restart.

   Note: If MultiFinder is dimmed in the dialog box (that is, it appears grayed out and can’t be selected), you probably don’t have enough memory available to use MultiFinder. Either purchase more RAM (probably not a bad idea anyway), or move some of your INITs and/or cdevs out of the System Folder and then restart your Mac.
Now that your machine is ready for Reagan, double-click the Reagan’s Watching icon. A title screen will appear briefly and then Reagan will materialize on your screen, accompanied by a brief auditory fanfare.

Now, since he only works in the background, we have to put him in the background—by making one of the Finder’s windows active. Select Finder from the Apple menu, and don’t click on Reagan. Fine. Now the Finder is in the foreground, and Reagan is in the background. Move the cursor around. See his eyes following it? Cute, eh?

Now for the fancy stuff—making him talk... Move the cursor so it’s right between his eyes, but don’t click. (If you click on him, Reagan becomes the foreground application, and he doesn’t talk when he’s in the foreground.) When his eyes cross (as shown in Figure 4, Reagan’s Talking), he’ll speak. It even works when he’s hidden by another window! Just move your cursor to the proper spot and he talks, even though you can’t see him.

Figure 4. Reagan’s Talking:
By moving your cursor to the position shown, you can get Ron to cross his eyes and talk to you. (Remember: Don’t click!)
You can have several Ronnies on screen. Just choose Add from the Reagan menu. When you have more than one Ron on screen, inactive Rons close their eyes; to activate a Ron, click on him.

To get rid of excess Rons, activate the one you want to delete, then choose Remove from the Reagan menu.

By the way: The comments are from Reagan’s 1990 Iran-Contra testimony and were digitized using Farallon’s SoundEdit.

(If there were such a thing as the Stupid Mac Trick Awards, the one for Most Significant Contribution would surely go to Farallon for MacRecorder and SoundEdit.)

**Suggestions for Using Reagan’s Watching**

There are a couple of things you might want to try. If you’re in an office where others will hear your Mac talking, try putting the cursor between Reagan’s eyes just before you walk away from your desk for a while. Ron will talk continuously until someone moves the cursor away from his nose or clicks on his face.

Another possibility: Launch Reagan, then hide his face behind a word processing (or any kind of) document. Every time the cursor is moved over the place where his nose would be if he were in the foreground, he speaks. Good for when friends use your computer, or for the person in the next cubicle. Maybe even the boss.

Don’t miss the About box. Choose About Reagan’s Watching from the Apple menu. Don’t click, or it will disappear without revealing all of its secrets. Just sit quietly and watch it until the end.

How will you know it’s over? Listen for the Tao Jones Software Theme...
Liner Notes:
Who's on First?

I don't know Mark Malamud, the twisted mind behind Tao Jones Software's Reagan's Watching, but he seems like fun. Though we've never met, or even spoken on the phone, through the magic of electronic mail, we have conversed.

He's a clever and outspoken guy. For example, he typed: "reagan's watching was named the third most pointless product of 1990 by macuser magazine. (third!?! frankly, i'm disappointed.)"

That's just how he typed it—no capital letters. I meant to ask him if his Shift key was broken, or if he was an e. e. cummings fan.

I bit. I typed back: "What were #1 and #2?"

He replied: "#2 was flying toasters from after dark (a fine program, but certainly not a 'pointless' one!) and #1 was eyes (a program that puts a pair of eyes in the menu bar that follows your cursor around the screen (—a watered down reagan's watching if you ask me!)"

You can decide for yourself if Eyeballs is just "a watered down reagan's watching"—it's part of Son of Stupid Mac Tricks. Even though Mark refers to it as "eyes," the INIT that puts the eyeballs in the menu bar is called Eyeballs, written by Ben Haller, and is one of the "Critters" included in this package. (See the section on Critters, later in this book.)

Historical footnote: There is also a program called Eyes. Here's how to tell 'em apart:
• Eyes is an application.
• Eyeballs is an INIT.
• Eyes creates one or more sets of eyeballs that can be moved or stretched anywhere onscreen except the menu bar.
• Eyeballs puts a single set of eyeballs in your menu bar.
• Eyes was part of the original Stupid Mac Tricks collection.
• Eyeballs is part of the Son of Stupid Mac Tricks collection.

Reagan’s Watching: The Fine Print

Reagan’s Watching © 1990 Mark Malamud.

If you register your copy, Tao Jones Software will send you the sonically robust (more sounds) version of Reagan’s Watching, and you’ll be guaranteed all future updates to Reagan’s Watching, as well as first dibs on future Tao Jones Software products. Better still, 100% of your registration fee will be donated to a nonprofit environmental organization.

To register, send $10 to: Mark Malamud, Tao Jones Software, 458 North 42nd Street, Seattle, WA 98103.

P.S.: Mark was kind enough to send me the “sonically robust (more sounds)” version. If you like the version that comes with Son of Stupid Mac Tricks, you’ll like the sonically robust version even better...
What Subliminal Does

According to my dictionary, subliminal (the word) means "designed to act on the mind at a subconscious level." Subliminal (the program) does just that—it sends messages designed to act on the mind at a subconscious level.

It's a do-it-yourself subliminal message kit, useful for influencing yourself or others, most notably spousal units and bosses. (See Figure 5, Brainwashing the Boss.) You have total control: how often messages appear, how long they appear for, and even what the messages say.

I don't know if it really works. I rather doubt it. You see, it's not really subliminal. Even its shortest display time (1 second) is long enough to recognize and read the message (as long as the message is short, or you're a fast reader). Truly subliminal messages would appear for fractions of a second, but they wouldn't be as silly or annoying.
Figure 5. Brainwashing the Boss:
You think you deserve a raise? Want to convince your boss? Put Subliminal on his (or her) machine, using the "Boss" file, and he (or she) will receive messages like these all day long. (Be sure to change "Your Name Here" to your actual name for best results.)
There are lots of ways to use Subliminal—as reminders to yourself, as a humorous reminder to your spouse or boss, or even to amuse your kids.

**How to Use Subliminal**

Subliminal is a cdev—a Control Panel Device. To activate it, open the Subliminal folder, move the Subliminal icon into your System Folder, and then restart your Mac.

Under System 6, choose Control Panel from the Apple menu and select the Subliminal icon from the scrolling list on the left. That will open the Subliminal Control Panel Device. (See Figure 6, *The Subliminal cdev.*)

Under System 7, when you drag the icon to the System Folder you’ll see a dialog box confirming that this is what you want to do. Click OK. Subliminal will automatically be placed in the Control Panels folder within your System Folder. Now restart your Mac. To use Subliminal, select Control Panels from the Apple menu and then double-click the Subliminal icon.

![Control Panel](image1)

![Subliminal](image2)

Figure 6. The Subliminal cdev:
Subliminal has an easy-to-use interface. Just choose a file and then select values for the “Appear every” and “Display for” fields. (System 6.0.x on left, System 7.0.x on right.)
To select a message file, click the Choose File button and a standard Open File dialog box will appear. Navigate to the Subliminal folder (it's in the Son of Stupid Mac Tricks Folder) and open one of the Subliminal files, either Boss or Self.

Now, click the Test button. You should see a message appear somewhere onscreen. The messages will continue to pop up at 2-second intervals until you click the mouse while a message is onscreen.

Subliminal has two other controls: “Appear every” sets the frequency with which messages appear; “Display for” sets the length of time a message stays onscreen. Both work the same way, using pop-up menus. To change either one, click on the number in the box and drag up or down until your choice is selected; then release the mouse. (See Figure 7, Choosing from the Pop-Up Menus.)

![Control Panel](image)

**Figure 7.** Choosing from the Pop-Up Menus:
To change the value for either pop-up menu, click on the number, drag until your choice is selected, and then release the mouse button.
The message files that Subliminal uses are plain text files. You can create and edit files for Subliminal with any word processor that lets you save in “text” format, which is sometimes called “ASCII” or “plain text.” Apple’s TeachText, the text reading and editing program that comes with every Mac, can also be used to create and edit files for Subliminal. (See Figure 8, Viewing and Editing a Subliminal File.)

TeachText saves files in the text format automatically, so if you’re not sure how to create a text file with your word processor, use TeachText.

There are only two things you need to know to create or change Subliminal files:

1. The file must be saved in text format.
2. Each message must end in a carriage return.

![Subliminal file-Self](image)

Figure 8. Viewing and Editing a Subliminal File: You can view and edit Subliminal files using any program that saves files in “text” format (Apple’s TeachText is shown).
One last thing: If you get a message that says "Subliminal is not currently installed. Please Restart to install Subliminal," you may not have enough memory available. Try moving one or more additional INITs or cdevs out of your System Folder (or Extension and Control Panels folders if you’re using System 7) temporarily and then restarting your Mac.

Note: I tested Subliminal with a beta version of System 7 and it worked. I can’t promise that it will work with the release version of System 7, but it should.

Suggestions for Using Subliminal

Here’s one I’d try if I had a boss: First, use a word processor or TeachText to open the file named Subliminal file—Boss. Change “Your Name Here” to your name. If there are special messages you want your boss to see, type them in. Save the file. (Remember, if you used your word processor, save the file in text format only.) (See Figure 9, Doin’ that Boss Thing.) Now, wait for a time when you and the boss’s Mac can be alone together for about 5 minutes. Copy the Subliminal file—Boss and the Subliminal cdev to a floppy, then copy them into your boss’s System Folder and restart the Mac. In the Control Panel, use the Choose File button to select Subliminal file—Boss. Set “Appear every” to 10 minutes and “Display for” to 2 seconds (to make absolutely sure he or she sees the messages). Now scram.
Figure 9. Doin’ that Boss Thing:
Change “Your Name Here” to your name, save the file, and away you go!

By the end of the day, your boss will give you anything you like as long as you promise you’ll make the messages stop!

As you might expect, I don’t recommend trying this on a boss with no sense of humor. And, of course, I can’t be held responsible for the consequences.

There are plenty of ways to use Subliminal. It’s a wonderful way to suggest things to your spouse. Try: “Wouldn’t a new Porsche look good in our garage?” or “Hawaii is nice this time of year.” Kids—get anything you want from your parents. Try: “Jason deserves a much bigger allowance” or “Allison would be safer if she had a new car.” Parents—use it to reinforce the rules. Try: “Home past midnight = grounded for a month” or “You will do all your chores, or else.”

Use your imagination. Remember, even at the fastest setting, 1 second, you can read most messages. So your so-called “subliminal” messages are almost certain to be seen. There must be hundreds of other things you can do with it. Go wild.
Subliminal: The Fine Print

Critters—Eyeballs and BigFoot

What Critters Does

Feeling lonesome? Critters will keep you and your Mac company. Critters is a pair of INITs that install a pair of goo-goo eyes in your menu bar (Eyeballs), and a pair of walking footprints on your desktop (BigFoot). They're well behaved, don't eat much, and are very (user?) friendly. They're also terminally cute. (See Figure 10, Invasion of the Desktop Critters.)

How to Use Critters

Critters is a pair of INITs, Eyeballs and BigFoot. To activate them, open the Critters folder and move the Eyeballs and BigFoot icons into your System Folder. Under System 7 you'll see a dialog confirming that you want to put these INITs in the Extensions folder. Click OK. Now restart your Mac.
Figure 10. Invasion of the Desktop Critters:
Critters puts Eyeballs in your menu bar and BigFoot on your desktop. The picture doesn't really do them justice—they're much cuter in real life, when they're moving to and fro!

The two INITs are independent of each other; you can use one, the other, or both. As you might expect, Eyeballs puts the eyes in your menu bar, and BigFoot puts the walking footprints on your desktop.

Note: I tested Eyeballs and BigFoot with a beta version of System 7 and it worked. I can't promise that it will work with the release version of System 7, but it should.

Suggestions for Using Critters
Critters are friendly fellows and can be installed on your own Mac to keep you company and amuse your friends and co-workers. Or drop them into the System Folder of a friend's or co-worker's Mac so they can be kept company and amused.
If you want to heighten the surprise, and divert suspicion from yourself (as the perpetrator), try copying both INITs into someone’s System Folder, but don’t restart their Mac. Since INITs don’t become active until the Mac is restarted, the critters will sit there, inert, until your unsuspecting victim restarts their Mac. When they do, they’ll get an entertaining surprise.

Critters: The Fine Print

Critters is the work of master programmer Ben Haller, the author of Solarian II, one of the greatest shareware Macintosh games ever created. For a copy of Solarian II, a Mac video game that requires 256 colors, send $25 and a self-addressed stamped envelope to: Stick Software, c/o Ben Haller, 32 Deer Haven Drive, Ithaca, NY 14850.
CursorAnimator

What CursorAnimator Does

CursorAnimator gets rid of the Mac's boring, you've-seen-'em-a-million-times cursors—like the arrow and the wristwatch—and replaces them with totally cool animated cursors.

CursorAnimator replaces that dull wristwatch with something exciting—an hourglass, bar graph, crystal, or moon—each of which undulates in its own hypnotic manner. There's even one that flashes the letters: "W-A-I-T." (See Figure 11, Animated Cursors.)

How to Use CursorAnimator

CursorAnimator is a cdev—a Control Panel Device. To activate it, open the CursorAnimator folder, move the CursorAnimator icon into your System Folder, and then restart your Mac.
Figure 11. Animated Cursors:
Instead of the boring wristwatch cursor, install a cool animated cursor with CursorAnimator!

Under System 6, choose Control Panel from the Apple menu and select the CursorAnimator icon from the scrolling list on the left. That will open the CursorAnimator Control Panel Device. (See Figure 12, *The CursorAnimator cdev*.)

Under System 7, when you drag the icon to the System Folder you'll see a dialog box confirming that this is what you want to do. Click OK. CursorAnimator will automatically be placed in the Control Panels folder within your System Folder. Now restart your Mac. To use CursorAnimator, select Control Panels from the Apple menu and then double-click the CursorAnimator icon.
Figure 12. The Cursor Animator cdev:
Replacing a boring System cursor with an exciting animated cursor is easy with Cursor Animator.

Figure 12, The Cursor Animator cdev, shows Cursor Animator as it looks when you use it for the first time. On the left are the five standard System cursors—I-beam, crosshair, plus, wristwatch, and arrow—with radio buttons beside them. Click a radio button to select the System cursor that you want to replace, then click a cursor from the list on the right. That’s all there is to it!

Cursor Animator has four buttons—Preview, Load, Rename, and Remove—that control all of its other features.

If you want to see what a cursor looks like, select it from the list and then click the Preview button. (See Figure 13, Cursor Preview.)

Another way to view a cursor is to double-click its name, which will show that cursor for five seconds.
Figure 13. Cursor Preview:
The Preview button brings up a dialog box, and the selected cursor is animated until you click OK.

The first time you use CursorAnimator, there will only be four cursors available—HourGlass, Plus, Small Arrow, and Caret (plus one called "default," which we'll get to in a minute). It's easy to add additional cursors—there are more than 45 on the disk.

To add more cursors, click the Load button and use the standard Open File dialog box to locate the folder called Cursor Collection. (See Figure 14, Loading Additional Cursors.) Inside the Cursor Collection folder you'll find nine folders containing more than 45 animated cursors. Each folder is named in honor of the "artist" who created those particular cursors. (If you're interested, the names of the artists can be found in the "CursorAnimator • READ ME" file, which also gives a bit of information on creating your own cursors using ResEdit. See the Glossary for more information about ResEdit.)
Note that, no matter how many cursors you load, CursorAnimator will only keep the selected cursor replacement or cursor animation in memory. So adding the cursors is a one-time procedure; once you’ve added all of the cursors in the collection, you’ll never have to do it again.

The Rename button lets you rename a cursor. Don’t like the name it came with? Change it to anything you like.

The Remove button removes previously installed cursors from the list. It doesn’t delete them from your hard disk, it just makes them unavailable to CursorAnimator until you reinstall them using the Load button.

If you get sick of a custom cursor and want your old, comfortable System cursor back, select “• Default •” from the list. The cursor will return to its default state—the standard System cursor.

Note: I tested CursorAnimator with a beta version of System 7 and it worked. I can’t promise that it will work with the release version of System 7, but it should.

Figure 14. Loading Additional Cursors:
Click the Load button, then find the Cursor Collection folder, which contains over 45 animated cursors.
Suggestions for Using CursorAnimator

Unlike some Stupid Mac Tricks, CursorAnimator is something you will probably want to run all the time. Once you get used to one of the animated cursors, the wristwatch will never be the same for you.

You can also have a good time changing other people’s cursors without telling them.

CursorAnimator supports two different kinds of cursors—static and animated. Animated cursors (HourGlass, Plus) are displayed in boldfaced type; static cursor replacements (Small Arrow, Caret) are in plain type. Most of the cursors in the Cursor Collection folder are animated.

You may find using an animated cursor to replace one of the static System cursors annoying. I do. On the other hand, I prefer any of the animated cursors to that stupid watch. So I only use CursorAnimator to replace the watch cursor, not my static System cursors—the crosshair, I-beam, plus, or arrow.

But please don’t take my word for it. You many enjoy replacing the arrow cursor with an animated one. Remember: You can’t hurt anything by experimenting. If you don’t like seeing a particular cursor, you can always choose “•Default•” from the list and that particular cursor will revert to the standard System cursor.

CursorAnimator: The Fine Print

CursorAnimator ©1990–91 by Wilhelm Plotz. It may be distributed free of charge, provided that the documentation is included.
P.S.: CursorAnimator is a clever piece of work. If you like it, why not send the author a postcard? You’ll make his day. (The one I sent was from my favorite BBQ joint in America—the Iron Works, here in Austin, Texas.) You can discover even more about CursorAnimator, its future, and the author’s address by reading “CursorAnimator • READ ME.” It’s a TeachText document you’ll find in the CursorAnimator folder. (Read it using Apple’s TeachText application, which is included with your System Software disks.)
Finder Sounds

What Finder Sounds Does

Finder Sounds adds sound to most of what you do in the Finder. Window openings are accompanied by a whoosh, window closings by a reverse whoosh. Pulling down a menu and making a selection from it each have their own distinctive harp-like sound. When you empty the Trash, you'll even hear the sound of a flushing toilet.

But wait, there's more. Sounds also play when you create folders; drag, move, or select windows; drag icons; open or close the About the Finder dialog box under the Apple menu and more. Finder Sounds has a complete collection of built-in sounds, but if you have sounds of your own, it's easy to use them instead.
How to Use Finder Sounds

Finder Sounds isn’t compatible with System 7. It only works with System 6.0.4 or later System 6 versions.

If you’re a MultiFinder user, you need to give the Finder some extra memory to ensure that Finder Sounds has enough to play all its sounds. (Once again, if you’re not sure how, take a look at the helpful sidebar.)

Liner Notes:
Helpful Sidebar—Increasing Finder Memory

1. Open the System Folder and select the Finder.
2. Choose Get Info from the File menu.
3. Type 256 into the Application Memory Size box. (See Figure 15, Increase Finder Memory.)

If you have only 1 megabyte of RAM, you should reverse this procedure when you’re done using Finder Sounds and set your Finder’s Application Memory Size back to 160.

Power User Tip: If you have 2 or more megabytes of RAM, you might want to leave the Finder set to 256K. This will be helpful if you run out of memory during file transfers or if you do a lot of disk-swapping when you copy files to floppies. Try leaving it at 256K long enough to determine whether it helps in your setup. I know it helps in mine.
Figure 15. Increase Finder Memory:
First select the Finder, then choose Get Info from the File menu (top). Type 256 into the Application Memory Size box.

Now that your Finder is properly prepared, let’s activate Finder Sounds. Open the Finder Sounds folder, move the Finder Sounds icon into your System Folder, and then restart your Mac. Once it restarts, choose Control Panel from the Apple menu and select the Finder Sounds icon. That will open the Finder Sounds Control Panel Device.
The Master on/off and Variable pitch sounds buttons should be checked. If they aren’t, check them now. Next, click on the Config button. (See Figure 16, Configuring Finder Sounds.)

![Control Panel: Finder Sounds configuration](image)

Figure 16. Configuring Finder Sounds:
Choose as many or as few sounds as you like. Command-click on any event to hear its sound.

The first time you use Finder Sounds, all of the events are checked. These checkboxes turn sound on (checked) or off (unchecked) for that event. That’s all there is to it.

To hear an event’s sound, hold down the Command key and click on its name. Try Command-clicking Empty Trash—you should hear a toilet flushing sound.
If you have sounds of your own, it’s easy to use them with Finder Sounds. The “Finder Sounds Read Me” file in the Finder Sounds folder explains how to do it.

More detailed usage and installation instructions are available in the file “Finder Sounds Read Me,” a TeachText document that you will find in the Finder Sounds folder.

**Suggestions for Using Finder Sounds**

Of course, you could drop Finder Sounds and Finder Sounds Config into someone’s System folder and then restart their Mac. Don’t forget that you’ll have to tinker with their Finder and give it more memory. Also, don’t forget to change it back after you’ve had your laugh.

When I use Finder Sounds on my Mac, I don’t keep all the sounds turned on. It’s a little too much for me with all of them enabled. Play around with it—you’ll probably find you enjoy certain sounds more than others. I like all the window sounds and the scroll bar noises. I turn almost everything else off.

**Finder Sounds: The Fine Print**

What Fruits of Passion Does

Fruits of Passion lets you replace the Apple icon in your menu bar with more than a dozen alternate icons—a banana, the Eiffel tower, the Microsoft Windows dash, a bandage, or even a partially eaten apple. (See Figure 17, Better than an Apple....)

Figure 17. Better than an Apple...:
Replace that boring old Apple icon with something a bit more fanciful. Top to bottom: France, MS/ Windows Tile, It hurts, Apple after....
The aforementioned banana looked like a blob in black and white and so is not included in the illustration. It does, however, look spectacular in color.

**How to Use Fruits of Passion**

Fruits of Passion is a cdev—a Control Panel Device. To activate it, open the Fruits of Passion folder, move the Fruits of Passion icon into your System Folder, and then restart your Mac.

Under System 6, choose Control Panel from the Apple menu and select the Fruits of Passion icon from the scrolling list on the left. That will open the Fruits of Passion Control Panel Device. (See Figure 18, *The Fruits of Passion cdev.*) Fruits of Passion does not work with System 7.

Fruits of Passion is simple to operate. The on/off switch should be on. The Startup Icon switch can be on or off, depending on whether you like to see icons for your cdevs and INITs when you start up your computer. Finally, there is a scrolling list of alternate icons. Click once on a name and you'll see the icon in the miniature menu in the Fruits of Passion cdev. Double-click a name and the new icon appears instead of your Apple. You don't have to restart your Mac to change icons.

If you're handy with ResEdit, the Passion Fruit Doc'n file, in the Passion Fruit folder, has rudimentary instructions for creating your own icons with ResEdit. See the Glossary for more information about ResEdit.

I tested Fruits of Passion with a beta version of System 7. Unfortunately, it didn't work. Perhaps it will work with the final released version of System 7, but I doubt it.
Figure 18. The Fruits of Passion cdev:
Choose a replacement for the boring old Apple icon in your menu bar.

**Suggestions for Using Fruits of Passion**

Fruits of Passion modifies your Apple menu for as long as you have it installed. So just pop it into your System Folder, restart, and then choose a replacement for your Apple.

You can, of course, install Fruits of Passion on other people’s computers. It should be good for a chuckle when they find their Apple has turned into the Eiffel tower, a bandage, trash can, disk, or any of the other chimical icons.

**Fruits of Passion: The Fine Print**

Fruits of Passion ©1989 by Chrisoft, All Rights Reserved. For suggestions or to make a bug report, write to Andres Christophe, 2, rue de Fréland, 67100 Strasbourg, France.
Shutdown Slide

What Shutdown Slide Does

Shutdown Slide is a one-trick pony of a Stupid Mac Trick. Once installed, every time you shut down your Mac, the screen appears to slide away. (See Figure 19, Sliding Into Shutdown.)

How to Use Shutdown Slide

Shutdown Slide is an INIT. To activate it, open the Shutdown Slide folder, move the Shutdown Slide icon into your System Folder, and then restart your Mac.

Under System 7, when you drag the icon to the System Folder you'll see a dialog box confirming that this is what you want to do. Click OK. Shutdown Slide will automatically be placed in the Extensions folder within your System Folder. Now restart your Mac.
Figure 19. Sliding Into Shutdown:
Shutdown Slide makes your screen appear to slide away whenever you choose Shut Down from the Finder's Special menu.

Shutdown Slide has no controls. You will see its icon briefly when you start your Mac (as you do for many INITs and cdevs), and once installed, it will make your screen slide every time you use Shut Down until you remove it from your System Folder and reboot.

Shutdown Slide chooses at random from five different sliding effects. On black-and-white Macs, the slide is pretty quick; on color Macs it's extremely slow.

Note: I tested Shutdown Slide with a beta version of System 7 and it worked. I can't promise that it will work with the release version of System 7, but it should.
Suggestions for Using Shutdown Slide

Like I said, it’s a one-trick pony. You drop it in your System Folder and enjoy it every time you use Shut Down.

If someone else is using your Mac (assuming they know anything about Macs), ask them to shut it down when they’re through. They’ll definitely notice that something is rotten in the state of Denmark.

Finally, you can install it on someone else’s Mac. When they ask you what’s going on, you have several options:

a) Be cruel. Feign ignorance.

b) Be exceptionally cruel. Say something like, “Your framus is about to fail. I hope all of your important files are backed up....” Then offer to repair it “at a good price.”

c) Let them in on the joke.

I take no responsibility for the consequences of any of these actions. Stuff like this can get you punched in the nose. In other words, think twice before doing it to someone bigger than you, someone who outranks you, or anyone who is in any way capable of making your life miserable.

On the other hand, stunts like these are perfect for the weasels in your life. Just remember: They might have a copy of one of the Stupid books, too. Don’t be surprised if you come in one day and find your Mac “stupified.”
Liner Notes:
From the Read Me File

Shutdown Slide is a little INIT that I wrote, just because I thought it would be neat to see the screen slide when I shut down my computer. It works on any size screen and is very slow in color. It currently slides the screen randomly in one of five ways.

I would like to make it a little smarter. For instance, if the screen is very large, scroll the image faster. The same goes for a Mac II with the color on.

I am trying to write a fade on shutdown and hopefully I can get that to work. It should look pretty nice. Maybe if I think of enough options, I can write a shutdown cdev.

If you have any comments or suggestions, if you love this program, or if you hate it, please tell me. I can be reached through the U.S. postal system.

Shutdown Slide: The Fine Print

Shutdown Slide by: Andrew McGeachie, 32 Dover Road, Wellesley, MA 02181.

P.S.: It's times like these that I wish I knew how to program for the Mac. "Shutdown Slide is a little INIT that I wrote, just because I thought it would be neat to see the screen slide when I shut down my computer." I wish I could do stuff like that! I've said it before, and I'll say it again—programmers who create Stupid Mac Tricks are truly heroes! May guys like Andrew never run out of crazy ideas.
Mouse Odometer

What Mouse Odometer Does

In the Mouse Odometer Read Me file, programmer Sean Nolan asks a question that’s been asked by Mac users since time immemorial:

"Have you ever wondered just how far your cursor travels in the course of a workday? Or how far it’s gone in the past year?"

With that in mind, I think you can guess what Mouse Odometer does. That’s right—it measures how far, in miles, your cursor has traveled. That’s all. But as you’ll soon see, Mouse Odometer is a very useful program indeed.

Hey, you asked for Stupid Mac Tricks. If this isn’t stupid, I don’t know what is.
How to Use Mouse Odometer

Mouse Odometer comes in two parts, an INIT (called “Mouse Odometer INIT”) and an application (called “Mouse Odometer”). So first you must load the Mouse Odometer INIT. Open the Mouse Odometer folder, move the Mouse Odometer INIT (not the Mouse Odometer) icon into your System Folder, and then restart your Mac. Under System 7 you’ll see a dialog confirming that you want to put Mouse Odometer INIT in the Extensions folder. Click OK. Now restart your Mac. After restarting, you will see Mouse Odometer’s icon briefly when you start your Mac (as you do for many INITs and cdevs). Once installed, the INIT will keep track of your “mileage” continuously.

To read your “mileage,” you use the Mouse Odometer application. Double-click the Mouse Odometer program (it should still be in the Mouse Odometer folder), which will open the Mouse Odometer window. (See Figure 20, The Odometer Itself.)

Figure 20. The Odometer Itself:
My cursor has traveled more than 8/10 (.88087) of a mile since I installed Mouse Odometer.
The top dial shows how far, in miles, your cursor has traveled since you installed the Mouse Odometer INIT; the bottom shows how far it's gone since you last rebooted the machine. The black-on-white cells represent whole numbers, the reversed cells (white-on-black) represent fractions. So, in Figure 20, *The Odometer Itself*, my cursor has traveled almost \( \frac{9}{10} \) (.88087) of a mile since I installed the Odometer, and less than \( \frac{2}{100} \) (.01878) of a mile since I rebooted.

To reset the bottom dial, click on the Trip button. Why might you do this? The Read Me file says it “might be fun if you want to measure ‘miles per document’ or something.”

Note: I tested Mouse Odometer with a beta version of System 7 and it worked. I can’t promise that it will work with the release version of System 7, but it should.

**Suggestions for Using Mouse Odometer**

Well, of course, you can install the INIT on your machine, then run the Mouse Odometer application every now and then to see how many miles you’ve put on. As long as the INIT is installed, Mouse Odometer will keep track of your mileage. Even if you don’t run the application for a while, the INIT is quietly accumulating your mouse-miles. You can just forget about it for a while, and, when you’re interested, run the application to see how many miles you’ve put on.

As the Read Me file says, you can use the Trip button to measure miles per document. An even better use might be to measure miles per computing session.

If you really want to waste some time with it, chart your daily mileage and then use a spreadsheet to analyze the numbers.
**Mouse Odometer: The Fine Print**

“This earth-shattering program is dedicated to Lara and my family. They’ve been saying I’m stupid for years, and now it’s in print. Wonderful...

“The Mouse Odometer is meant for fun and is priced accordingly. It’s shareware, so play with it for awhile before you decide if it’s something you’d like to keep. If it is, purchase it for $5, which should be sent to the following address. I also welcome any comments or bug reports (although I won’t be thrilled to hear the latter).”

Sean Nolan, Dartmouth HB 2658, Hanover, NH 03755.
NavCom

What NavCom Does

NavCom is a little MultiFinder application that gives an interesting ambience to your Mac screen by creating the illusion that a lot of things are going on. It creates small windoids, up to 30 of them at a time, that flicker and flash and change as though they contained important up-to-the-minute data. They don’t. They just contain graphics and text designed to make your Mac look important. (See Figure 21, NavCom Windoids Go Wild.)

How to Use NavCom

NavCom is an application—a program. Just double-click its icon to start it. It works under both Finder and MultiFinder, but the effect is more interesting under MultiFinder with at least one other program running. The windoids use color on machines so equipped, but it works fine in black and white as well.
When you first start NavCom, it will open with a single windoid showing. (See Figure 22, Windoid Management.) To add a new windoid, choose New Window in the File menu (or use the Command-key shortcut, Command-N). You can add as many as 30 windoids, but performance is better with fewer. I usually run 10 or 12, but I have a Mac IIcx. If you have a slower Mac, you might want to try even fewer...
Figure 22. Windoid Management:
The first time you launch NavCom, you'll see just one windoid (top). Use the New Window command (middle) to add up to 30 windoids; then click and drag them anywhere on your screen (bottom).
Windoids can be dragged anywhere on your screen by clicking on them and dragging. You get a neat effect when you keep several of them touching—they look like one window with several "compartments." Another hint: Place windoids near the edges of the screen so they show when you’re using another application under MultiFinder.

Once you’ve gotten the windoids in a position you find aesthetically pleasing, choose the Save Window Positions command. Now, whenever you use NavCom, it will look like it did when you chose Save Window Positions. To change this setting, just move the icons to where you want them and choose Save Window Positions again.

When you choose Save Window Positions, NavCom creates a small file called "NavCom Positions" and stores it in a folder containing the NavCom program. If you want NavCom to forget your windoid positions and start up with a single windoid again, just toss the NavCom Positions file in the Trash.

NavCom uses only about 60K of RAM, so you won’t be wasting a lot of valuable memory when you leave it running in the background.

When you get sick of it, remember that it’s an application. Just Quit and it’s gone.

About NavCom, a TeachText file you’ll find in the NavCom folder, has some interesting background material on the program, including instructions for adding your own picture windoids using ResEdit. (See the Glossary for more information about ResEdit.)

Note: I tested NavCom with a beta version of System 7 and it worked. I can’t promise that it will work with the release version of System 7, but it should.
Suggestions for Using NavCom

NavCom is lots of fun. It will impress your friends, amaze your co-workers, and generally make your Mac look cool.

If you want it around all the time, you can use the Finder’s Set Startup command (System 6) or the Startup Items folder (System 7) to launch it automatically whenever you turn on your Mac.

You can have fun installing it on a friend’s or co-worker’s machine. Be sure and make up a good story to go with it. Tell ’em it’s their mandatory radiation detector, which federal law says all computers must have. Or tell them it’s a high-tech security system to keep foreign spy satellites from penetrating your Mac from outer space. That’s what I say when people ask.

NavCom, unlike most Stupid Mac Tricks, has staying power. You’ll want to keep it handy and run it whenever someone you want to impress (or tease) is expected.

Liner Notes:
More about NavCom

The About NavCom file, which you’ll find in the NavCom folder, contains (among other information) the following:

“NavCom started long, long ago when I first saw 2001: A Space Odyssey, in 1968. It was a neat film, but neatest of all were the displays in the spacecraft that kept flashing up information all the time. They really gave a feeling of lots of heavy technical stuff going on all the time automatically. Ever since, I’ve wanted displays like that of my own.
"At work at Apple, I was working on a background application for another purpose. Once I had the basic background stuff worked out (not very hard), I realized that I was within striking distance of my long-awaited background displays. I started working on it on a Friday night. Three or four hours later I had the basic program working. By the end of the weekend, NavCom 1.0.

"NavCom has no redeeming social value that I can detect. However, just to prove that nothing is totally worthless, here are some uses for it: making computer-naive people think your system is incredibly advanced and sophisticated; giving people a taste of the future, when agents and other autonomous processes are constantly running around doing things behind your back; justifying that color monitor you bought but don’t have any applications that use color.

"Needless to say, NavCom is free. Give it to anyone. Enjoy."

**NavCom: The Fine Print**

NavCom was written by Harry R. Chesley purely for the joy of writing neat software. It's free to anyone who wants it.
ARRGH!!!

What ARRGH!!! Does

ARRGH!!! is just the thing when you’re totally frustrated and just feel like screaming. Why waste your breath? Let your Mac do the screaming for you.

When ARRGH!!! is active your Mac will, at random intervals, emit a blood-curdling scream, a scream that ARRGH!!!’s creator says “sounds a little like Sam Kinison.” It doesn’t really, but it’s still quite an attention-getter.

How to Use ARRGH!!!

ARRGH!!! is an INIT. To activate it, open the ARRGH!!! folder, move the ARRGH!!! icon into your System Folder, and then restart your Mac. Under System 7 you’ll see a dialog confirming that you want to put ARRGH!!! in the Extensions folder. Click OK. Now restart your Mac.
ARRGH!!! has no controls. You will see its icon briefly when you start your Mac (as you do for many INITs and cdevs), and it will scream once when it loads. From then on, it will make your Mac scream at random intervals until you remove it from your System Folder and reboot.

It's that easy. There are no controls and no interface. Just drop it in your System Folder, reboot, and enjoy.

This chapter, unlike the others, has no illustrations. That's because there's nothing to show. ARRGH!!! is totally auditory and it's completely invisible (except for the little icon and scream at startup time).

Note: I tested ARRGH!!! with a beta version of System 7 and it worked. I can't promise that it will work with the release version of System 7, but it should.

Suggestions for Using ARRGH!!!

Well, if you enjoy being startled, you can always install ARRGH!!! on your own Mac. I know several people who run it all the time, just because. If your Mac is frequently used by other people, this may be an interesting thing to try—if you can stand it screaming in the middle of your work.

You can always install it just before someone else is going to use your Mac. Before they arrive, simply drag the ARRGH!!! icon into the System Folder and restart. Don't forget to move it out of the System Folder and restart before you go back to work.

I prefer installing it on someone else's Mac. Just sneak in and drop ARRGH!!! into their System Folder. Now, there are two things you can do—restart their Mac or shut it down. If you restart their computer, the screaming will start immediately. If you shut it down, the next time
they turn on their Mac they’ll be greeted with a scream at startup, which will be followed by periodic shrieking.

If they happen to ask you why their Mac is suddenly screaming all the time, tell them that it’s possessed and cheerfully offer to perform the exorcism.

ARRGH!!!: The Fine Print

ARRGH!!! was written by Herb M. Goodman, author of HMG ResEdit Primer, with special thanks to the unknown author of the original Obnoxious INIT.
BigBen

What BigBen Does

BigBen, a reproduction of the famous Big Ben clock, sits innocently on your screen. (See Figure 23, BigBen Itself.) Innocently, at least, until it chimes on the hour. When that happens, prepare yourself for a lengthy bell concerto (just how lengthy depends on what hour it is). On the hour you’ll hear the BigBen theme (Bong-bing-bing-bong/Bing-bang-bang-bang), followed by the appropriate number of bings for the current hour.

Liner Notes:
Historical Footnote

Big Ben is the giant bell-ringing clock in the tower of the Houses of Parliament in London. It is named for Sir Benjamin Hall, who was England’s Commissioner of Works in 1856, when the bell was installed. The name originally referred only to the 13-ton bell.
Figure 23. BigBen Itself:
This is what BigBen looks like.

**How to Use BigBen**

BigBen is a desk accessory. Under System 6, you’ll have to install it in your System file using Font/DA Mover. Font/DA Mover should have been supplied with your Mac on one of the System Tools disks. The instructions for using it can be found in the documentation that came with your Mac. If you have either Suitcase or MasterJuggler installed on your Mac, you can use one of them instead of Font/DA Mover.

If you use Font/DA Mover, there is a limit of 15 desk accessories under System 6. If you already have 15 installed, you’ll have to remove one to make room for BigBen. Also, if you’re using MultiFinder, you’ll need to restart your Mac each time you install a desk accessory.
Since System 7 turns desk accessories into double-clickable applications, to use BigBen with System 7, simply double-click the BigBen suitcase icon. In the window that opens, you'll see a BigBen application icon. (See Figure 24, Suitcase and Application Icons.) Drag this icon wherever you like. If you want BigBen to appear in the Apple menu, drag the application icon to the Apple Menu Items folder; if you want to store it somewhere else, that's fine, too. (Once you've dragged the BigBen application icon out of the suitcase, you can trash the BigBenII suitcase icon—it's no longer necessary, unless you want to pass it along to a friend who's running System 6.0.x.)

![Figure 24. Suitcase and Application Icons: Double-click the suitcase icon (left) and drag the application icon (right) wherever you like.](image)

Once you've installed it, BigBen is easy to use. Just pull down the Apple menu and select BigBen (or, under System 7, double-click the BigBen application icon). Leave the clock anywhere on your screen. When the hour changes, you'll be treated to the major melodiousness of gigantic bells played in glorious digitized Macintosh sound.

Note: While the sound is playing, you'll be unable to use your Mac for anything else.

BigBen works under Finder and MultiFinder (System 6) and was tested with a beta version of System 7. I can't promise that it will work with the release version of System 7, but it should.
Suggestions for Using BigBen

What more is there to say? You open BigBen and leave it running. On the hour you'll be treated to a festival of gongs.

BigBen: The Fine Print

BigBen was created by Riccardo Ettore.

P.S.: Riccardo also wrote Sound Manager, the ultimate shareware sound management package, which is available from online services and user groups.
Key Lights

What Key Lights Does

You want to talk about stupid tricks, Key Lights makes the num lock, caps lock, and scroll lock lights on Apple Extended Keyboards flash. You can set the speed and direction of the flashing and create an exceptionally stupid light show on your keyboard.

Key Lights only works with Apple Extended Keyboards—the ones with the little lights in the upper right-hand corner.

How to Use Key Lights

Key Lights is a cdev—a Control Panel Device. To activate it, open the Key Lights folder, move the Key Lights icon into your System Folder, and then restart your Mac.
Once you’ve restarted, Key Lights will be turned on and will create a light show without any further interaction on your part. But the lights are configurable; if you want to change their direction, speed, or normal/inverseness, use the Key Lights Control Panel.

Under System 6, choose Control Panel from the Apple menu and select the Key Lights icon from the scrolling list on the left. That will open the Key Lights Control Panel Device. (See Figure 25, The Key Lights cdev.)

Under System 7, when you drag the icon to the System Folder you’ll see a dialog box confirming that this is what you want to do. Click OK. Key Lights will automatically be placed in the Control Panels folder within your System Folder. Now restart your Mac. To use Key Lights, select Control Panels from the Apple menu and then double-click the Key Lights icon.

Figure 25. The Key Lights cdev:
Key Lights generates a light show with the otherwise inert num lock, caps lock, and scroll lock lights on your Apple Extended Keyboard.
Suggestions for Using Key Lights

Of course, you can run Key Lights on your own Mac, to amaze, amuse, and tickle the fancy of all who sit at your desk. It’s also sort of fun to install it on someone else’s Mac. They’ll see the little lights blinking, but chances are they won’t have a clue as to why.

Key Lights: The Fine Print

Key Lights is free and may be distributed for free or for only a nominal duplication fee. Give it to your friends. Enjoy.
What Shakespeare Does

Billed as "Shakespeare in a toaster," Shakespeare is a program that generates sonnets, 14-line poems with traditional rules of structure and rhyme. While this Shakespeare's sonnets rarely make sense, they are usually amusing and, occasionally, hilarious.

How to Use Shakespeare

Shakespeare is an application—a program. Just double-click its icon to start it. It works under both Finder and MultiFinder.

When you launch Shakespeare, the first thing you'll see is a credit screen with a picture of Shakespeare himself. Click the OK button, and you'll see the Help Window. (See Figure 26, Shakespeare Can Help.) The Help Window pretty much tells you everything you need to know to get Shakespeare to write a sonnet for you.
Figure 26. Shakespeare Can Help:
Shakespeare's Help Window appears when you launch the program and is always available in the Apple menu.

To generate a new sonnet, choose New Sonnet from the File menu (it might take a while). Once you've created a sonnet, you can use the Rewrite Current Sonnet button (the top button in the tool palette) to replace all or part of your poem. If there are lines you want to retain, click on them once to "freeze" them. Frozen lines appear in italic type. (See Figure 27, Sonnet by Shakespeare.)

The other two buttons in the palette allow you to save a sonnet to disk or reopen a sonnet that you saved previously. The Save and Open commands in the File menu mimic the functions of these two buttons.

When you save a sonnet, it can be opened again with Shakespeare, a text editor (for example, TeachText), or a word processor. You can also print your sonnet using either the Print Sonnet command in the File menu, or, if you want to print it in your choice of fonts, you can save your sonnet to disk and then open, format, and print it using your word processor.
Figure 27. Sonnet by Shakespeare:
Click once on a line to "freeze" it; the frozen lines appear in italic type. Clicking the Rewrite Current Sonnet button will replace all but the last two lines, "Fibrosis idiotic ringside pile, Perverse arrange particular beguile."

You can edit Shakespeare’s word list and add your own words to its vocabulary, but it’s not particularly intuitive and will require quite a bit of trial and error. If you’re brave enough to give it a try, choose Manage Words (Command-M) from the Edit menu. This opens the Manage Wordlist window. To add a word, type it into the Word field, then make selections regarding how the word sounds from the “Scans like,” “Vowel type,” and “Consonant” pop-up menus. To invoke these pop-up menus, click to the right of their names, as shown in Figure 28, Managing Shakespeare’s Words. You’ll have to experiment to get your words to work just right; I still haven’t quite gotten the hang of it.
Figure 28. Managing Shakespeare's Words:
You can even add your own words to Shakespeare's vocabulary in the
Manage Wordlist window.

Note: I tested Shakespeare with a beta version of
System 7 and it worked. I can't promise that it will work
with the release version of System 7, but it should.

Suggestions for Using Shakespeare
Unlike other stupid tricks, Shakespeare can't easily be
inflicted on the unsuspecting. Or can it? You can always
create a sonnet and send it to a loved one. Don't sign it.
They'll go crazy trying to figure out who their secret
admirer with the penchant for poetry is.

Shakespeare: The Fine Print
Shakespeare Mac Version © 1991 Bob Schumaker. This
program is Happiware—if you like it, smile!
What Sexplosion II Does

Sexplosion is a practical joke you can play on your terminally curious friends and co-workers. They’ll take one look at Sexplosion II’s suggestive icon and be overcome by the desire to double-click it, just to see what happens. But it won’t be what they expect…. When you double-click Sexplosion II, nothing sexy or dirty happens. No indeed! Instead, you’ll hear the sound of shattering glass and see your monitor appear to break into pieces. (See Figure 29, The Screen Sexplodes.) Of course, it’s totally harmless—a click or key press will return you to the Finder!
How to Use Sexplosion II

Sexplosion II is an application—a program. Just double-click its icon to start it. It works under both Finder and MultiFinder. To make it go away, press any key or click the mouse.

Note: I tested Sexplosion II with a beta version of System 7 and it worked. I’ve heard reports from others that it didn’t work properly on their machines running System 7. Use Sexplosion II with caution if you’re running System 7.
Suggestions for Using Sexplosion II

This one is perfect for leaving on a friend's or co-worker's gray desktop. Nobody can resist double-clicking the risqué icon; when they do, they'll get a big surprise.

You might even want to change the name from "Sexplosion II" to something like "Sexplosion II—Rated XXX," to pique their curiosity even further. (See Figure 30, Rated XXX.)

Figure 30. Rated XXX:
For a real good time, add the words "Rated XXX" to the icon and leave it in the middle of someone's desktop!

Sexplosion II: The Fine Print

Sexplosion II © 1991 Bob Schumaker. This program is Happiware—if you like it, smile!
Glossary

Application (a.k.a. Program)
Applications are programs; they run when you double-click their icon. Reagan's Watching, Mouse Odometer, NavCom, Shakespeare, and Sexplosion II are applications.

cdev (a.k.a. Control Panel Device)
A file you place in your System Folder and access through the Control Panel desk accessory under System 6 or by double-clicking its icon under System 7. You must restart your computer after copying the cdev to your System Folder to activate it. CursorAnimator, Finder Sounds, Subliminal, Fruits of Passion, and Key Lights are cdevs.

Commercial Software
Software sold by publishers. Commercial software may not be copied or given away. Examples: Microsoft Word, PageMaker.

See also Freeware; Shareware.
Control Panel

The desk accessory you use to access cdevs under System 6. Under System 7, Control Panels are stored in a special Control Panels folder within your System Folder and are accessed by choosing Control Panels from the Apple menu and then double-clicking the appropriate icon.

See also cdev.

Desk Accessory (a.k.a. DA)

Special mini-programs available in the Apple menu (System 6 or 7) or by double-clicking their icon (System 7 only). Under System 6, desk accessories can be used even when you have an application running—with or without using MultiFinder. BigBen is a desk accessory.

See also Font/DA Mover.

Finder

A special file, part of your necessary System software, that manages opening, closing, moving, naming, and trashing files and folders, and mounting and ejecting disks. The Finder runs automatically whenever you start up your Mac and is responsible for managing the desktop you see when you turn on your Mac. You must have, at the very least, a System and a Finder on any disk used to start up your Mac, and the System and Finder files must always be in a special folder that must be named the System Folder.
Font/DA Mover

Apple-supplied application used for installing and removing fonts and desk accessories from your System file. Under System 7, it is unnecessary—you install fonts by dragging them into the System file and use Desk Accessories by either double-clicking their icon or choosing them from the Apple menu.

Freeware

Software for which there is no charge and that can be copied and given away freely.

INIT (a.k.a. Initial or Startup Document)

A file you place in your System Folder that installs itself when you start up your computer. Shutdown Slide, ARRGHI!!!, Mouse Odometer INIT, Eyeballs, and BigFoot are INITs.

MultiFinder

Apple operating system software—in versions 5.0.x and 6.0.x—that lets you run several programs at the same time. So, for example, if you're not using MultiFinder and you want to copy a paragraph from Microsoft Word and paste it into MacPaint, you would have to copy the text in Word, quit Word, open MacPaint, and then paste the text. Under MultiFinder you could launch both Word and MacPaint and switch between them by clicking in their respective windows. For more information, take a look at the manual that came with your Mac. Under System 7 there is no distinction between Finder and MultiFinder—MultiFinder is always turned on.
**Online Service**

A large, commercial BBS (bulletin board system). Online services let computer users who have modems upload and download text and programs and leave messages for other users. You can also shop for a wide variety of products, buy and sell stocks, make travel reservations, and search huge electronic databases for specific information. Fees average from $5 to $20 an hour. I first saw most of the tricks in this book after downloading them from an online service. CompuServe, GEnie, and America Online are the most popular online services for Macintosh users.

**Read Me File (a.k.a. Doc File)**

A text file that comes with other software. Whenever you see a Read Me or Doc file in a folder, you should read it before you proceed. If you double-click one and get a message that says “An application can’t be found for this document,” launch your word processor (or the TeachText application that comes on most Apple System Software disks) and use its Open command to open the Read Me file.

**ResEdit**

ResEdit is Apple Computer’s resource editing software. All Macintosh software is made up of resources — menus, cursors, icons, dialog boxes, etc. When you’re adept with ResEdit, you can change menu items, colors, and Command keys, altering wording in dialog boxes, edit icons, and much more.
Unless you're an Apple developer, you can't get ResEdit directly from Apple, but it is widely available. If you have a modem, you can download the latest version from CompuServe, America Online, or GEnie for the cost of your download time.

If you don't have a modem, the Berkeley Macintosh User's Group (BMUG), offers ResEdit on disk for $4, plus $3 for postage and handling.

I know of two good books, both of which include a copy of ResEdit on disk. The first, Zen and the Art of Resource Editing ($15.00; BMUG, 1442A Walnut St. # 62, Berkeley, CA 94704; 415-549-BMUG), is an excellent introduction. It's short, well-written, and will get you started with ResEdit quite nicely. The other book, ResEdit Complete ($29.95; Addison-Wesley, 1 Jacob Way, Reading, MA, 01867; 800-447-2226), is thorough—almost six times as thick as Zen. It not only includes information for the beginner, but goes on to become far more technical.

**Shareware**

Try-before-you-buy software. Can be copied and given out freely, but if you use it regularly, you are honor-bound to send some money to the author. In some cases (Reagan's Watching), you receive a more capable version if you register. In other cases (Mouse Odometer), you get nothing more than the peace of mind that comes from doing the right thing. Reagan's Watching and Mouse Odometer are the only shareware programs in this collection. If you like them, don't be ashamed to send a shareware donation. Thanks.
System 6
An earlier version of Macintosh System Software. Many of you are probably still using it. Its chief advantages over the newer System 7 are that it doesn’t require a hard disk, and only requires 1Mb of RAM. (System 7 requires a hard disk and 2Mb of RAM.)

Since there are numerous versions of System 6 (6.0.1, 6.0.2, etc.), we use the designation 6.0.x to refer to them.

System 7
The current version of Macintosh System Software. Differs in many ways from earlier versions, including a better Finder, aliases, built-in file sharing, more versatile memory options, TrueType font support, and much more.

Since there will probably be numerous versions of System 7 (7.0.1, 7.0.2, etc.), we use the designation 7.0.x to refer to them.

User Group (a.k.a. MUG—Macintosh User Group)
A club made up of Macintosh enthusiasts. There are over 1,000 such clubs in North America. Most hold regular meetings and classes, publish a newsletter, obtain discounts on goods and services, and maintain shareware/freeware libraries for their members. To find the user group nearest you, call 1-800-538-9696, Ext. 500.
SON OF
STUPID MAC TRICKS

BOB LEVITUS

The verdict is in on Stupid Mac Tricks...

"Stupid Mac Tricks? Boy, there's truth in advertising. I love 'em!"
—Harry Anderson, TV's "Night Court"

"A compendium of 14 silly, nonproductive, sophomoric, and in some cases essential programs that can be loaded into a Mac—yours or your designated victim's."
—The New York Times

"The perfect gift for any Mac hack...[Stupid Mac Tricks] may be your smartest gift."
—Bay Area Computer Currents

"If you think Stupid Pet Tricks is funny, you'll fall off your keyboard at Stupid Mac Tricks."
—CompuServe's "OnLine Today"

Programs in Son of Stupid Mac Tricks include:

CRITTERS
REAGAN'S WATCHING
SUBLIMINAL
SHAKESPEARE
ARRGH!

Just when you thought it was safe to turn on your Macintosh, there was Stupid Mac Tricks, the best-selling book-and-software package containing 14 programs ever for the Macintosh. Watch Ronald Reagan turn into a bouncing happy face, flash signatures into your screen, and much, much more!

Bob LeVitus, author of the bestselling Stupid Mac Tricks and Stupid PC Tricks, is a specialist on showing users how to get the most out of the Macintosh.

System Requirements:
Macintosh Plus, SE, Portable, LC, or II family computer; hard disk drive; and System Software Version 6.0.2 or later

Cover design by Ronn Campisi
Addison-Wesley Publishing Company, Inc.